
PSYCHOLOGICAL SCALES scales.arabpsychology.com

How to Quickly Delete Every Other
Column in Excel

Authored by

stats writer

February 22, 2026

RECOMMENDED CITATION

stats writer (2026). How to Quickly Delete Every Other Column in Excel. PSYCHOLOGICAL

SCALES. Retrieved from https://scales.arabpsychology.com/?p=132116

ARABPSYCHOLOGY.C
OM

https://scales.arabpsychology.com/?p=132116
https://scales.arabpsychology.com/?p=132116
https://scales.arabpsychology.com/?p=132116
https://scales.arabpsychology.com
https://scales.arabpsychology.com


How to Quickly Delete Every Other Column in Excel 2

PSYCHOLOGICAL SCALES scales.arabpsychology.com

Introduction to Efficient Spreadsheet Management

In the realm of data analysis and administrative organization, Microsoft Excel stands as a

cornerstone tool for managing vast quantities of information. Often, when importing data from

external sources such as a database or a web scraper, the resulting spreadsheet may contain

redundant information or "filler" columns that obscure the primary data. Learning how to efficiently

refine these datasets is a vital skill for anyone looking to optimize their workflow. Specifically, the

task of removing every other column is a frequent requirement when dealing with datasets that pair

raw data with metadata or calculated fields that are no longer necessary for the final report.

The challenge with manual data manipulation is that it is inherently prone to error and becomes

exponentially more difficult as the size of the spreadsheet increases. If you are working with

hundreds of columns, manually clicking each one while holding down the Ctrl key is not only

tedious but also risks accidental deletions or missed selections. Therefore, implementing a

systematic methodology--such as using a helper row combined with a horizontal sorting

algorithm--provides a robust solution that ensures accuracy and saves significant time. This

approach allows users to categorize columns into "Keep" and "Delete" groups, effectively

streamlining the management of big data within a familiar environment.

By mastering these advanced techniques, users can transform cluttered worksheets into

professional, readable reports. This guide will walk you through a professional-grade method to

delete alternating columns using a combination of logic and built-in Microsoft Excel features. We

will explore the step-by-step process of preparing your data, utilizing helper rows, and applying

advanced sorting criteria to achieve a clean, focused dataset that highlights only the most

pertinent information for your stakeholders.

Step 1: Establishing the Initial Dataset

Before we begin the technical process of modification, it is essential to have a well-structured

dataset to work with. In this example, we will consider a scenario involving annual sales figures for

a retail organization. Suppose you have a spreadsheet that lists sales values across eight

consecutive years, where each year occupies its own column. The objective is to refine this list so

that we only retain odd-numbered years--specifically Year 1, Year 3, Year 5, and Year 7--

effectively removing the intervening even-numbered years to simplify the data visualization

process.
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To follow along with this tutorial, ensure your data is clearly labeled in the first few rows of the

worksheet. Proper labeling is a fundamental aspect of information management as it prevents

confusion during complex operations. Once your data is entered, you will notice that the columns

are currently ordered sequentially. Our goal is to manipulate this data structure so that the

columns we wish to remove are grouped together, making the final deletion process a single,

efficient action rather than a repetitive series of clicks.
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The beauty of the method described in the following steps is its versatility. While our example

focuses on eight years of sales data, the same logic can be applied to thousands of columns

across any industry. Whether you are managing financial records, scientific observations, or

inventory tracking, the ability to selectively prune your data without compromising the integrity of

the remaining values is a high-level skill that differentiates expert users from novices. Let us

proceed by preparing the sheet for the sorting process.

Step 2: Implementing a Helper Row for Logical Selection

The most effective way to handle alternating columns is to introduce a helper row. This temporary

row serves as a logical guide for Excel's sorting engine, allowing the software to distinguish

between the columns you intend to keep and those you intend to discard. To begin, navigate to the

top of your worksheet, right-click on the header of the first row, and select Insert from the context

menu. This will create a new, blank Row 1 above your existing headers, providing the necessary

space for our logical tags.
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Once the new row is in place, we will apply a simple labeling system. In cell A1, type the keyword

Keep, and in cell B1, type the keyword Delete. These labels act as metadata that the sort

function will later use to reorganize the spreadsheet. By explicitly defining the status of the first

two columns, we establish a pattern that can be quickly replicated across the entire width of the

dataset using Excel's powerful AutoFill feature.

To extend this pattern, highlight both cells A1 and B1. Position your cursor over the small green

square at the bottom-right corner of the selection--this is known as the fill handle. Click and drag

the handle to the right across all columns in your dataset. You will see that Excel automatically

alternates the words Keep and Delete for every column. This automation eliminates the need for

manual typing and ensures that the alternating pattern is perfectly consistent throughout the range.
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Step 3: Configuring Advanced Horizontal Sorting

Standard sorting in spreadsheets typically occurs vertically, moving rows up and down based on

alphabetical or numerical values. However, to solve our current problem, we must utilize a less

common feature: horizontal sorting. First, highlight the entire range of your data, including the

new helper row. Navigate to the Data tab on the Excel Ribbon and locate the Sort & Filter group.

Clicking the Sort icon will open a comprehensive dialog box that offers advanced configuration

options for your data reorganization.

Inside the Sort window, you must change the default behavior of the software. Click the Options

button located near the top of the box. A smaller window will appear, presenting you with the

choice of "Sort top to bottom" or "Sort left to right." Select the Sort left to right option and click

OK. This tells the application that you want to move the columns themselves rather than the rows
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within the columns, which is the key to grouping our "Delete" columns together.

Now that the orientation is set, you must specify the sorting criteria. In the Sort by dropdown

menu, select Row 1, as this is where our "Keep" and "Delete" labels reside. Ensure that the sort

order is set to A to Z. Because "Delete" starts with "D" and "Keep" starts with "K," the alphabetical

sort will naturally place all columns labeled "Delete" at the beginning of your worksheet and all

columns labeled "Keep" toward the end. Click OK to execute the command and watch as your

data architecture is instantly rearranged.
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Step 4: Executing the Final Column Deletion

After the horizontal sort is complete, your spreadsheet will look significantly different. All the

columns you marked for removal are now clustered together on the left side of the screen. This

clustering is the final objective of our sorting strategy, as it allows for a bulk deletion. Instead of

hunting through the sheet for alternating columns, you can now see a clear block of data that is no

longer required for your analysis.ARABPSYCHOLOGY.C
OM
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To finalize the process, click on the header of the first "Delete" column and drag your mouse to

highlight all columns containing that label. Once the range is selected, right-click anywhere within

the highlighted area to summon the context menu and select Delete. Alternatively, you can use

the Delete group in the Home tab of the Ribbon. Because the columns were grouped by the

sorting algorithm, this single action removes all the unnecessary data simultaneously, leaving

only the "Keep" columns behind.
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The final result is a streamlined spreadsheet containing only the specific years of sales data we

initially intended to preserve. At this stage, you should also remove the helper row (Row 1) by

right-clicking the row header and selecting Delete. This restores your original headers to the top of

the sheet. This professional technique ensures that your data integrity remains intact while

drastically reducing the time spent on manual formatting and cleaning tasks.ARABPSYCHOLOGY.C
OM
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Alternative Selection Methods and Keyboard Shortcuts

While the sorting method is the most reliable for massive datasets, smaller tasks can be handled

using keyboard shortcuts to speed up the process. For users who prefer a more "hands-on"

approach, the Ctrl key method remains a staple of spreadsheet software usage. By holding

down the Ctrl key, you can perform non-contiguous selection, allowing you to click on multiple

column headers (A, C, E, etc.) simultaneously. Once selected, a single right-click and "Delete"

command will clear them all. This is often faster for datasets containing fewer than twenty columns.

Another powerful tool for selection is the Go To Special feature found within the Find & Select

menu. While more commonly used to find formulas or blank cells, advanced users can combine

this with specific row values to highlight large areas of a sheet. Understanding these shortcuts is

essential for maintaining a high productivity level. For instance, using Ctrl + Minus (-) on a

selected column is the professional's way to trigger a deletion without ever touching the mouse,

further streamlining the user experience.

For those interested in automation beyond manual sorting, Visual Basic for Applications (VBA)

offers a way to script this entire process. A simple macro can be written to loop through all

columns in a selection and delete every second one automatically. This is particularly useful for

recurring reports where the same data cleaning steps must be performed weekly or monthly. By

saving the macro to your Personal Macro Workbook, you can make this "delete every other

column" feature available across all your Excel files with a single click.
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Best Practices for Data Integrity and Accuracy

Whenever you perform bulk deletions or major structural changes to a workbook, prioritizing

data integrity is paramount. Before running a sort or deleting columns, it is highly recommended

to create a backup of your file or duplicate the worksheet. This provides a "safety net" in case the

sorting parameters were set incorrectly or if you accidentally delete a column containing vital

formulas or source data. Maintaining version control is a standard practice in professional data

management and prevents the loss of hours of work.

Furthermore, be mindful of cell references. If other sheets in your workbook are linked to the

columns you are about to delete, those links may break, resulting in the dreaded #REF! error.

Before deleting, use the Trace Dependents tool in the Formulas tab to see if the data you are

removing is being used elsewhere. If it is, you may need to convert those formulas to static values

first or update the references to point to the columns you are keeping. This level of diligence

ensures that your financial modeling or statistical analysis remains accurate post-cleanup.

Finally, always perform a visual audit of your data after the deletion is complete. Check that the

remaining columns are the ones you intended to keep and that no data has shifted unexpectedly.

Microsoft Excel is a powerful tool, but it relies on the user to provide correct logical inputs. By

combining the helper row strategy with a careful review process, you can ensure that your reports

are not only clean and professional but also factually sound and ready for executive presentation.

Summary of Efficient Workflow Practices

In conclusion, deleting every other column in Excel does not have to be a tedious manual task. By

leveraging the helper row technique and horizontal sorting, you can transform a complex data

cleaning chore into a simple, three-step process. This method is scalable, reliable, and reduces

the risk of human error, making it the preferred choice for data scientists and office professionals

alike. Remember that the key steps involve inserting a helper row, using AutoFill to create a

logical pattern, and configuring the Sort Options to move columns from left to right.

The following tutorials explain how to perform other common operations in Excel:

How to Remove Duplicate Rows: A guide to cleaning your data by identifying and removing

identical records to ensure data quality.

Mastering Pivot Tables: Learn how to summarize large datasets into meaningful business

intelligence reports.

Advanced VLOOKUP and XLOOKUP: Techniques for retrieving data across multiple worksheets

and tables efficiently.

Using Conditional Formatting: A tutorial on how to visually highlight outliers and trends within

your spreadsheet data.
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By continuing to build your technical skills in Excel, you will become more efficient in handling

complex datasets and more valuable to your organization. Whether you choose to use the sorting

method, keyboard shortcuts, or VBA macros, the goal remains the same: to produce clear,

accurate, and actionable data. We encourage you to explore our other Excel tutorials to further

enhance your proficiency in data analysis and reporting.
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